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Fiery proServer User Guide

This document describes how to connect and set up your Fiery proServer and keep it in good

working condition after installation. It deals with the following topics:

Connecting the Fiery proServer (see page 1)

Hardware components, including Fiery QuickTouch (see page 3)
Starting, shutting down and rebooting the Fiery proServer (see page 5)
Changing the language of Fiery proServer (see page 8)

Updating the Fiery proServer software (see page 8)

Starting the Fiery proServer software (see page 9)

Backing up and restoring the Fiery proServer system (see page 10)
Licensing the Fiery proServer software (see page 12)

Using anti-virus software (see page 13)

Troubleshooting (see page 14)

Fiery proServer documentation and help (see page 17)

Connecting the Fiery proServer

IMPORTANT
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All required cables and components are provided in the Fiery proServer shipping box.

Keep the following guidelines in mind when making connections:

Be sure to use the appropriate power cable for your regional outlet type.

The dongle is required to use the Fiery server software. If the dongle is not installed or is
removed during a work session, the Fiery server software will be unavailable.

By factory default, the upper Ethernet port is configured for DHCP, which means that it
can dynamically request IP addresses. Use the upper Ethernet port to connect the Fiery
proServer to your company network.

The lower Ethernet port provides an optional isolated network segment for the printer. If
the Fiery proServer and printer are both on the company network, you do not need to use
this port. However, if you wish to establish an isolated network connection between the
Fiery proServer and printer, connect a cable from the lower Ethernet port to the printer.
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TO CONNECT CABLES AND COMPONENTS

1 Connect the cables and components to the Fiery proServer.

Fiery proServer back panel
1 Power cable
2 Keyboard and mouse

3 Network cable (straight-
through Ethernet cable)

4 Display port
5 Fiery proServer software
dongle

6 Inkjet printer cable

®
000
. E} 003800000000 (@)
I] I] l g880808888600060

00000000600060000

© @ T

o
90000000000000000000
[ 0000000000000000000000
[} 0000000000 0000000000
000000000; 00000000
© 00000000 00000000
9006600 0000000
9000000 0000000
9000000 0000000
© 0000000 000000
00000000 00000000
00066000 60000000
0000000000 00000000
o 0Q00000000000000000Q0!
30000000000000000000
® 000000000000000Q0
0000000
500000

()
@/
S
-
o




Hardware components

Front and side panels
The front and side panels consist of the following components:

Fiery proServer front and side
panels
1 Fiery QuickTouch LCD @

2 DVD drive (inside, behind
door)

3 Power button

4 USB 3.0 ports (x3)
5 Reset button @
6 Front panel door

)

Fiery QuickTouch

The Fiery QuickTouch LCD on the front of the Fiery proServer allows you to do the
following:

* Shut down, or reboot the Fiery proServer
* Restart the Fiery server

* Change the brightness setting of the LCD



By default, Fiery QuickTouch displays Idle after startup, which indicates that no jobs are
currently being processed. To display the Fiery QuickTouch main menu, press the ellipsis icon
(three dots) at the top right of the display.

Fiery QuickTouch main menu

= S

Shutdown system Reboot system Restart server Brightness

Precautions

Observe the following precautions when using Fiery QuickTouch:

* Avoid pressing the surface of the liquid crystal display (LCD).
Applying pressure to the LCD causes it to change color.

¢ Use a soft cloth moistened with lens cleaner to clean the surface of the LCD.
Other solvents, such as water, may damage the LCD.

¢ Handle the LCD with care.

If the LCD breaks and the liquid crystal inside leaks out, avoid contact. If you do come in
contact with the liquid crystal, immediately wash it off your skin with soap and water.



Status messages

Fiery QuickTouch displays the following status messages:

Starting up The Fiery proServer is starting.

Idle The Fiery server is started, but is not processed jobs.
Busy The Fiery server is processing jobs.

Fiery services are not responding The Fiery server is not started.

Commands

Fiery QuickTouch has four commands. To display the commands, press the ellipsis icon
(three dots) at the top right of the display.

You can select a command by pressing the corresponding icon on Fiery QuickTouch.

Shutdown system Shuts down Fiery proServer.
Reboot system Restarts Fiery proServer.
Restart server Restarts the Fiery server. The connection to the Fiery proServer

software is automatically interrupted when you select this command.

Brightness Enables you to adjust the brightness of the Fiery QuickTouch LCD.
You can also use this command to dim the display when it is inactive.

Starting, shutting down, and rebooting the Fiery proServer

IMPORTANT

You can generally leave the Fiery proServer and the printer running all the time. However, this
section also describes how to shut down, and reboot the Fiery proServer when necessary.

Always use the following procedures. Do not use the reset button on the side of the Fiery

proServer to shut down or reboot the system.



TO START THE FIERY PROSERVER
1 Set the power switch on the back of the Fiery proServer to the On (|) position.

Rear view
1 Power switch
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2 Power on the Fiery proServer.

Press once and release the button to power on the system. The power supply automatically

senses the correct voltage.

Side view
1 Power button




3 At the Admin logon on the monitor, enter Fiery.1 in the password field, and then press
<Enter>.

Type Fiery.1 exactly. The password is case-sensitive; for example, fiery.1 will not work.

4 Allow startup to proceed until the Fiery proServer desktop appears on the monitor, and Fiery
QuickTouch displays Idle.

The Fiery proServer takes approximately two minutes to start up. If you are starting Fiery
proServer for the first time, you are required to license the Fiery proServer software as part of
the installation procedure. For more information, see page 12.

By default, the Windows taskbar is hidden. The taskbar contains:
. E Fiery XF Control, a tool for controlling the Fiery server

. E:,q Fiery System Tools, a tool for changing the language of all Fiery proServer hardware
and software components, and for backing up and restoring the Fiery proServer system.

5 To display the Windows taskbar, do one of the following:
* To display the taskbar momentarily, move the pointer to the bottom of the screen.

* To display the taskbar at all times, right-click the taskbar and then click Settings. On the
Taskbar tab, set “Lock the taskbar” to on, and “Automatically hide the taskbar in desktop
mode” to off.

The Fiery XF Control icon is not immediately visible in the status area of the taskbar. Click
the up arrow to show hidden icons, and then drag the Fiery XF Control icon from the hidden
icon area to the status area.

The Fiery proServer software starts automatically. Make sure the latest program version is
installed before setting up the software. For more information, see page 8.

TO SHUT DOWN THE FIERY PROSERVER

1 Verify that the Fiery proServer is not receiving, processing, or printing any files.

If the system has just finished processing, wait at least five seconds after the system reaches
Idle before you proceed.

2 Exit the Fiery proServer software.
On the File menu, click Exit to close the client.
3 On the Fiery QuickTouch main menu, press Shutdown system.

Allow the system to shut down completely.

To REBOOT THE FIERY PROSERVER

If a USB flash drive is attached to the Fiery proServer, remove it before rebooting. Otherwise,
the Fiery proServer will not reboot.

1 Verify that the Fiery proServer is not receiving, processing, or printing any files.

If the system has just finished processing, wait at least five seconds after the system reaches
Idle before you proceed.



2 Exit the Fiery proServer software.

On the File menu, click Exit to close the client.

On the Fiery QuickTouch main menu, press Reboot system.

Wait for the system to reboot and the login window to appear on the monitor.
Enter the Admin password, and then press <Enter>.

Fiery.1 is the default Admin password and is case-sensitive. If your administrator has changed
the password, and the new password is lost, you must reset the Fiery proServer to its factory
state. For more information, see page 11.

When you have logged on, the Fiery proServer desktop appears.

Changing the language of the Fiery proServer

If needed, you can change the system language.

Note: The language change takes up to 15 minutes to complete. When the language change is
in progress, it cannot be aborted.

The language change is applied to the operating system and keyboard, Fiery XF Control and
the Fiery proServer software.

TO CHANGE THE LANGUAGE OF THE FIERY PROSERVER

1 In the Windows taskbar, start Fiery System Tools.

2 Click Change system language, and select a language from the drop-down list box.

If you change the language, you need to restart the system.

The Fiery proServer software also has its own language setting which overrides the language
setting made for the Fiery proServer. For more information, see page 9.

Updating the Fiery proServer software

IMPORTANT

Before setting up the software, make sure that it is up to date. To update the software, the
Fiery proServer must be connected to the Internet.

It is essential to ensure that you have the latest version of the software installed on your
computer. A notification appears at the bottom of the Fiery proServer software window when
a free-of-charge update is available. The notification remains until you have updated your
system.

TO INSTALL A PROGRAM UPDATE

1 Exit the Fiery proServer software.

2 Right-click the Fiery XF Control icon, and click Fiery XF Online Update.

The Updater dialog box appears.



3 Click Next.

A dialog box with a list of currently available software updates appears. It indicates which
update files are available and also gives information about file size and version number.

4 Select the check boxes of the updates you want to install, and click Next.

5 Follow the on-screen instructions to download the updated files, and to complete
installation.

6 Restart your computer, if prompted to do so.

For more information, see also the online help of the Fiery proServer software.

Starting the Fiery proServer software

The Fiery proServer client starts automatically whenever you start the Fiery proServer. If you
exit the Fiery proServer client for any reason, you can restart it.

To START THE FIERY PROSERVER CLIENT

1 Do one of the following:
e Double-click the !L icon on the desktop.
* Right-click Fiery XF Control, and click Fiery XF Client Start.

The Welcome screen appears every time you start the Fiery proServer software. It provides
information on new program features as well as on the status of your Software Maintenance &
Support Contract (SMSA). You can renew your SMSA by clicking on the appropriate link in
the Welcome screen.

Changing the language of the Fiery proServer software

The Fiery proServer software has its own language setting which overrides the language setting
made for the Fiery proServer. This makes it possible to display the software in a different
language from the operating system and Fiery XF Control.

TO CHANGE THE LANGUAGE SETTING OF THE FIERY PROSERVER SOFTWARE

Note: To display one of the supported Asian languages, the software must be running on an
operating system that supports double-byte fonts.

1 In System Manager, on the Edit menu, click Languages and then click a language.

2 Restart the Fiery proServer client for the new language to take effect.
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Backing up and restoring the Fiery proServer system

A Fiery proServer system backup enables you to restore the Fiery proServer to an earlier state
in case of a problem, without having to return it to its factory settings.

It is recommended that you create a backup when you have set up the Fiery proServer system,
and then approximately once every three months.

Backing up your Fiery proServer system

Backing up the Fiery proServer system can take up to one hour, depending on the backup
medium used and the volume of job data.

TO BACK UP YOUR FIERY PROSERVER SYSTEM

1
2
3

In the Windows taskbar, start Fiery System Tools.
Click Back up your system.

Select one of the following backup destination:

e USB flash drive

¢ External HDD

e Network share

e Subfolder of the local hard disk

Select “Include Fiery job files in backup” (optional).

Be aware that job files can be backed up, but not the output files that reside in the Export
folder due to their size.

If your system backup file will be created on a USB flash drive or an external HDD, plug the
device into a USB port on the Fiery proServer.

Click Next.
Click Restart.

The backup process is complete when the system returns to Windows.

Restoring your Fiery proServer system

It may occasionally be necessary to return the Fiery proServer system to an earlier state. You
can do this by:

* Using a previously created backup

* Returning the Fiery proServer system to its factory state
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To RESTORE FIERY PROSERVER SYSTEM SETTINGS FROM A PREVIOUSLY CREATED BACKUP

The Fiery proServer system is restored with all the settings, including system environments,
that were current at the time the backup was created. Any settings made after the backup was
created are lost.

The restore procedure may take up to one hour, depending on the backup medium used and
the volume of job data.

1 Make sure that the system backup file is accessible from one of the following locations:
e USB flash drive
e External HDD
* Network share

2 If your system backup file is stored on a USB flash drive or an external HDD, plug the device
into a USB port on the Fiery proServer.

3 In the Windows taskbar, start Fiery System Tools.
4 Click Restore system from a previous backup.
5 Select the backup to restore on the replacement system and click Next.

If you created a backup in a network share, click Search Network. Type the network location
and logon information, and then click OK to log on to the server. Then, select the backup

that you want to restore.
6 Click Continue to confirm that you want to erase all the data on the hard disk drive.
7 Continue to follow the on-screen instructions.

At the end of the procedure, Windows starts automatically. You do not need to reinstall the
license if the Fiery proServer software was already licensed before the backup.

To RETURN FIERY PROSERVER TO ITS FACTORY STATE

You need to return the Fiery proServer to its factory state, for example, if the default password
has been changed and the new password has been misplaced. The Fiery proServer software
license and all your client software settings, including system environments, are deleted from

the hard disk drives.
1 In the Windows taskbar, start Fiery System Tools.
2 Click Restore to factory defaults.

3 Click Restart to confirm that you want to erase all the data on the hard disk drive and to start
the restore procedure.

At the end of the procedure, Windows starts automatically. You need to reinstall the license
for the Fiery proServer software. For more information, see page 12.
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Licensing the Fiery proServer software

The Activation Wizard starts automatically if the software is not licensed. You need to install a

license file:
* After installing the Fiery proServer system

* After returning the Fiery proServer system to its factory state

If problems arise when trying to download a license file through the Activation Wizard, go to
http://activation.efi.com, and follow the on-screen instructions to generate a license file
manually. You can receive a license file that has been generated by the activation website by e-

mail or by saving it to a specified location on your computer.

TO INSTALL THE LICENSE DURING SYSTEM SETUP

10

To create a license file, you need the EAC code which you will find on the Product Activation
Certificate inside the product packaging. If the Product Activation Certificate is missing from

the scope of delivery, contact your EFI service/support center for assistance.

After licensing, store the Entitlement Access Code (EAC) and all media shipped with the
Fiery proServer in a safe location, so that it is accessible to service personnel in case of a future
service call.

Make sure that the dongle is inserted firmly into a USB port on the back panel of the Fiery
proServer and that the dongle LED is lit.

In the Activation wizard, click the Automatically tab.

Click “Generate and activate new license”.

Enter the EAC code in the appropriate boxes.

The EAC code is case-sensitive.

Click Continue With User Details.

Read carefully the information about product registration. Then click Next Step.
Fill out the form with your user registration details.

If you have previously registered an EFI product, the form is filled out automatically when
you type your e-mail address and click Retrieve.

Click Install License.
A license file is created and downloaded to the FlexLM folder on your computer.
Click Finish to exit the Activation Wizard.

Restart Fiery proServer.


http://activation.efi.com
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TO REINSTALL THE LICENSE AFTER RESTORING TO FACTORY STATE

1

(S, B N Y]

Make sure that the dongle is inserted firmly into a USB port on the back panel of the Fiery
proServer and that the dongle LED is lit.

In the Activation wizard, click the Automatically tab.
Select “Download previously created license”, and then click Download Activated Licenses.
Click Finish to exit the Activation Wizard.

Restart Fiery proServer.

Anti-virus software

The Fiery proServer does not come with anti-virus software preinstalled. In production
environments in which files are regularly exchanged with customers, it is strongly

recommended that you install an anti-virus program of your choice.

When installing an anti-virus program, make sure that the following network ports are not
blocked as they are needed for specific features of the Fiery proServer software:

Port Used for

4108 Epson Spectroproofer

8010 Bi-directional communication service

8020, 8022 Integration and connectivity between Fiery proServer server and EFI
printers

8051, 8052, 8053, 8054, Communication between Fiery proServer server and APPE processes

8061, 8062, 8063, 8064 (up to four instances)

27000 to 27009, 60000 License management/EFI Cut Server

50005 to 50026 General communication between Fiery proServer server and Fiery

proServer client

20020 to 20021 (UDP only) | Fiery proServer discovery

If you install an anti-virus program, it is recommended that you do not disable virus detection

for jobs.
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Troubleshooting

The following sections describe the source of common problems that may occur with the
Fiery proServer, and suggest ways of correcting them.

Checking the Fiery proServer configuration

This section describes the quick checks that you can do to make sure that the problem is not
caused by an incorrect Fiery proServer configuration.

Does the Fiery proServer start up normally?

If, during startup, you hear 4 beeps, followed by 3 beeps, followed by 1 beep, followed by
2 beeps, there may be a problem with the memory. Contact your authorized service/support
center.

Is the Fiery XF Control icon green, indicating that Fiery XF Control is running?

The Fiery XF Control icon is located in the Windows system tray. If the icon is red, try the
following:

U Right-click the icon and click Fiery XF Server Start.

Observe the Fiery XF Control dialog box that appears as Fiery proServer searches for the
dongle and license.

If the dongle is found, the dialog box displays the dongle ID and continues searching for the

license.

¢ If the dongle and license are found, the dialog box closes and the Fiery XF Control icon

turns green.

* If the dongle and license are not found, the dialog box closes and the Fiery XF Control
icon remains red. Verify that the dongle is securely connected as described below, and
choose Fiery XF Server Start again; if the Fiery XF Control icon is still red, you may need
to reinstall the Fiery proServer software license, as described on page 12.

U Verify that no unauthorized software is installed on the Fiery proServer.

Third-party applications are not supported and can cause system problems. Although anti-
virus software is permitted on the Fiery proServer, you should run virus scans only when the
Fiery proServer is in Idle mode (not processing or printing any jobs).

U Verify that the Fiery proServer software dongle is present and securely connected to a USB
port on the back of the Fiery proServer, and the dongle LED is lit.

If the dongle is connected to a USB port but the dongle LED is not lit, try the following
suggested actions. If the problem persists after performing an action, go on to the next action.

* Connect the dongle to a different USB port on the back of the Fiery proServer.

* Open the Device Manager in Windows and verify that the dongle driver is installed
correctly.

* Perform a Windows update.
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* Reinstall the dongle driver from the manufacturer’s site: ftp://ftp.aladdin.com/pub/hasp/
Sentinel HASP/Runtime_%?28Drivers%29/Sentinel_ HASP_Run-time_setup.zip

* Obtain and connect a different dongle.

Is the connection to the printer properly configured?
Try the following:
Use theFiery proServer software to send a test job to the printer.

For more information, see the online help and the documentation that accompanies the
printer.

Restart the printer.

If the problem persists, you may need to test and service the printer. For more information,
see the documentation that accompanies the printer.

Verify that the problem is not caused by a particular print job or application.

Try printing a different job or using a different printing application.

Is the network functioning, and is the Fiery proServer properly connected to the
network?

Verify the following:

The Fiery proServer appears in the list of computers on the network.

If the Fiery proServer does not appear in the list of computers on the network, another device
on the network may have been assigned the same Ethernet hardware address.

The Fiery proServer DHCP setting matches the DHCP setting of the customer’s network.

If DHCP error messages appear on the monitor, the Fiery proServer may be searching for a
non-existent DHCP server. DHCP is enabled by default on the Fiery proServer, but the
customer’s network may not be using DHCP. In this case, you need to configure a static IP
address for the Fiery proServer.

If the problem persists, check the interface connections. For more information, see page 16.

Is the setting for showing hidden files selected?

You must be able to access some files in the ProgramData folder for certain troubleshooting

purposes.

TO DISPLAY HIDDEN FILES

1
2
3
4
5

Move the mouse pointer to the lower-left corner of the screen to see the Windows icon.
Right-click the Windows icon, and then click Control Panel.

Set Control Panel to view by small icons.

Click File Explorer Options, and then click the View tab.

Under Advanced Settings, select Files and Folders > Hidden files and folders, and click “Show
hidden files, folders, and drives.”


ftp://ftp.aladdin.com/pub/hasp/Sentinel_HASP/Runtime_%28Drivers%29/Sentinel_HASP_Run-time_setup.zip
ftp://ftp.aladdin.com/pub/hasp/Sentinel_HASP/Runtime_%28Drivers%29/Sentinel_HASP_Run-time_setup.zip

6
7
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Clear “Hide extensions for known file types.”

Click OK to confirm the changes.

Is the JobFolder folder shared?

The JobFolder folder must be shared to allow access to hot folders.

TO ENABLE SHARING WITH THE JOBFOLDER FOLDER

1

2
3
4
5

On the C:\ drive, right-click the “Jobs” folder and click Properties.

On the Sharing tab, click Advanced Sharing.

Select “Share this folder”, and click Permissions.

Select “Everyone”, and set the permission level to “Read and change”. Then, click Apply.

Click OK to confirm the changes, and close all windows.

Is the Output folder shared?

The Export directory must be shared so that the printer has access to pull output files from
the Fiery proServer.

TO ENABLE SHARING WITH THE OUTPUT FOLDER

1.

CAE A

Right-click the OQutput folder and click Properties.

Depending on your model of Fiery proServer, the Output folder is located either on the D:\
or E:\ drive.

On the Sharing tab, click Advanced Sharing.
Select “Share this folder”, and click Permissions.
Select “Everyone”, and set the permission level to “Read and change”. Then, click Apply.

Click OK to confirm the changes, and close all window.

Checking interface connections

This section describes the quick checks that you can do to make sure that the problem is not
caused by a loose connection at the back of the Fiery proServer.

Verify the following:

All components and interface cables to the system are securely plugged into the correct ports
on the back of the Fiery proServer. After verifying the connections, reboot the Fiery
proServer.

For an illustration of the correct ports and connections at the back of the Fiery proServer, see
page 2.
The power cable is plugged into the power outlet, and the Fiery proServer is powered on.

For more information, see page 6. If the Fiery proServer does not start, try replacing the

power cable with a new or tested cable.
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Q The upper LED next to the network port is on or blinking to indicate network activity.

If the upper LED is off, verify that the network cable is properly connected to the correct
network port on the Fiery proServer and to the network device on the customer network. If
the problem persists, try replacing the network cable with a new or tested cable.

Troubleshooting corrupted system software

If verifying the Fiery proServer configuration and connections do not correct the problem, the
problem may be caused by corrupted system software.

To remedy the problem, restore the Fiery proServer system to an earlier state as described on
page 10.

Fiery proServer documentation and help

Fiery proServer system PDF documentation
The Fiery proServer system documentation consists of the following:

* The Installation Guide provides information of preparing the site for installation, network
requirements, and installing the furniture.

* The User Guide describes how to connect and set up your Fiery proServer system and
software, including creating and restoring a backup, updating, the Fiery proServer
software, returning the Fiery proServer system to its factory state, changing the language,
licensing, and troubleshooting.

* The Quick Start Guide teaches you how to set up and use the Fiery proServer software
with your printer.

You need Adobe Acrobat Reader in order to access the Fiery proServer documentation, which
is provided in PDF format.

TO DOWNLOAD DOCUMENTATION FOR THE FIERY PROSERVER

1

On the Fiery proServer desktop, double-click the Download Adobe Reader icon to open the
Adobe website. Then, download and install Adobe Acrobat Reader.

Start Internet Explorer and type http://help.efi.com

If needed, in the Windows taskbar, click the Search icon, and search for Internet Explorer to
open the browser window. Then type https://get.adobe.com/reader.

Scroll down to Fiery Servers and Software for Production/Proofing, and click the link for your
Fiery proServer product.

Click the links for your product version and language to download the latest document.
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Fiery proServer software online help
The Fiery proServer software includes a comprehensive help system:

* The application help provides detailed information on how to set up and use each feature
of the software. From the Help menu, click Help.

* The context-sensitive help gives a brief description of the settings on each pane. You can
access the context-sensitive help via the menu buttons in property inspector. Right-click a
menu button on the right of a pane bar, and click Help.
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